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Links to AWA

PROD: http://awaprod.isadm.oregonstate.edu/prod

PPRD (for testers): http://awadev.isadm.oregonstate.edu/pprd

Log on and navigating to My Catalog

e Log on with OSU’s single sign on and DUO.

e Broadcom’s default login screen has a bad habit of occasionally appearing. If you see the Web
Interface screen (below) instead of the normal OSU single sign-on, set the following values to

force it to use single sign-on
o Login Type = SAML
o Client = 1000 (1300 for PPRD)
o Department = ONID
o Click “Next” to sign on


http://awaprod.isadm.oregonstate.edu/prod
http://awadev.isadm.oregonstate.edu/pprd

Web Interface

Language = English

Connection | PROD (AWAPROD)

Login Type %
Client m

Departmentl | ONID

Enable autologin

Connection Color | [ | No Color

Mext

Don’t bother logging out when done—you’ll again see Broadcom’s login screen—just close the
browser tab.
If prompted, accept notifications

To locate workflows, go to My Catalog
o Click on “+v” at the top of the screen and select My Catalog

My Dashboards = M Catalog ] Wl
Process Monitoring
= Add Dashboard
Queus
Q, Search All Qe

i

o Click on Catalog in the left Navigation panel



Favorites ¢ Lo

Activit

SHOW:

There are currently no
favorites available for your
user.

|

Catalog

Executing a workflow

e From the catalog menu, select a catalog (ARSYS, FINAID, etc.) to view available workflows
e Select the desired workflow and click “P»> Execute”
e  Confirm execution
e [f task requires input, provide it in one of two ways:
o An Input required box will be briefly displayed. Click on the Open link to enter input

) Task submitted for execution. D Messages

7o) B wycatalog  +

Favorites Se Hom @) Input mqu
TBR2040 Accotints Receivable Bankruptcy Report

Catalog [l Activities JOBP.ARSYS.TBR2040 istory
[l catalog » []| ACCOUNTS RECEIVABLE Today - Wednesc
SHOW:  All
TBC1200: Updates the student's rate code o1
% JOBP.ARSYS TEC1200 12:07 PM ﬁ
T TBR1410: Load GRA Rate Codes
JOBPARSYS TER1410 12:05 PM ﬁ
TBR1870: Auto Release Of Deposits
%: OBPARSYS TER1870 Yesterday - Tues!
TBR1905: Individual 1098-T Copy B 02:26 PM ‘7[
%j JOBP ARSYS TBR1505

o If the Input required box disappears, click on the Requests prompt in the top menu bar



) B wycatalog + H Requests - @

- N

Favorites e

Lol &l Activities Hist
[ catalog » []| ACCOUNTS RECEIVABLE Todz

SHOW: | All
fo  TBC1200: Updates the student's rate code o1
JOBP.ARSYS.TBC1200 12
TER2040: Accounts Receivable Bankruptcy Report
TBR1410: Load GRA Rate Codes JOBRARSYS TER2040
% JOBPARSYS. TER1410 Started Estimated finish: 7 12

E‘j Waiting for user input
|1F TBR1870: Auto Release Of Deposits
71 JOBPARSYS TER1B70 (7EL

e Select the desired task

e Enter values as prompted

e Click Submit

o Click the arrow in the Request ribbon to return to the Catalog

! My Catalog +

@ i Requests

Filter Select

e Note...this screen does not automatically refresh frequently. If running processes do not appear
in the Activities or (when complete) History panes, click the green arrows/refresh button to
refresh the screen manually

uests @ Messages Search

History
Today - Wednesday, January 8, 2020

1909 BV ﬂg TER2040: Accounts Receivable Bankruptcy Report

Checking execution results

e Click on the desired execution instance on the History pane. This opens a separate History
window.



o If necessary, expand the Name column to view the full name

< Executions of JOBP.ARSYS.TBR2040 (10)
Title: TER2040: Accounts Receivable Bankruptcy Report Las

5€ Cancel lip Restat [ D zie B} Open Moniter Mo

Ll

Mame @pe?' Platform RuniD P
3 @JOBP.ARSYS.TBRE[MG OBP 1935312

4 @JOBP.ARSYS.TBR2D40 JOBP 1936051
b @JOBP.ARSYS.TBRZED% JOBP 193531
3 E‘JOBP.ARSYS.TBRﬂMG JOBP 1935214

e See execution status in Status field

Viewing output files

e C(Click » expansion arrow in front of desired execution instance
e Right-click on JOBS.COMMON.REGISTER_FILES
e Select Open Report

< g Executions of JOBP.ARSYS.TBR2040 (10)
Title: TER2040: Accounts Receivable Bankruptcy Report Last Update

€ Cancel i Restart [} Deactivate &} Open Monitor More  ~
Mame Type Platform
@E‘JOBPARSYS.TBREMU Joep

i CALL.COMMON.EMAIL_REGISTERED_FILES CALL
AORS Linix
Cpen Monitor o

(_Ef.,}JOBS.COMMON.REGISTER_FILES
f2JOBS.COMMON.MAKEPDF
i%JOBS ARSYS. TBR2040_SOR

Nz
iy N n
8 Open Parent Monitor  p

» T JOBPARSYS.TBR2040 ' Open Report r
» T JOBP ARSYS TBR2040 BN Execution Lists >
» TP JOBPARSYS.TBR2040 Bp Restart

e To view additional files/directory content, use the pull down menu above the displayed
contents



! My Catalog @ Process Monitoring

& | B Report of JOBS.COMMON.REGISTER_FILES
Title: Register files & get email recipients RuniD: 1935315

Report {(REP) O Show latest output Fage

( Script (REVD) ists: /san/smf/pprd/banout/J0OBP.ARSYS.T
i ) . ilgn_pw PPRD SAISPRD

H ObJECt aCcess [REV2 PEEREE RS R R SRR R R R R R R R R w S
L '.3.8+build. 1568768698641 changelist 156
. Activation {ACT) pOBER19822) START AT  98.01.2828 / 12:
' JCL(REV) UTC TIME  98.91.2828 / 28:
i ° ted "

] . Besrs s mr st A e e SRR SRR SRR R SRS
H REDDH(REPI L e S s S i et
! Postconditions (POCO) !.3.8+build. 1568768698641 changelist 156
1 #P@A@19522) ENDED AT  ©8.81.2028 / 12:
+ Directory UTC TIME  98.91.2828 / 28:
. J " RETCODE=2@

B b T T T T e L s r T T

e If the navigation flummoxes you, check your email. A link to this page is added to emails
sent when the workflow completes.

Restarting a workflow

*** Be aware ***
AWA handles restarting differently than Appworx. Specifically, it alters input values in
unexpected ways.

When you select a previous execution of a workflow to be restarted and you alter the input
values to be passed, AWA updates those values on *both* executions (the execution you are
about to launch *and* the previous execution you selected to restart).

Furthermore, even if you cancel the execution before entering new input values, the values for
the previous execution are erased.

See the Notes and Known issues section for more information about this behavior
3k sk %k 3k 5k %k %k %k %k %k %k %k k %k k

e From the history pane, select a past execution to restart
e Click on Restart

& J]:ﬂ. Executions of JOBP.ARSY S.TER2040 (11)
Title: TER2040: Accounts Receivable Bankruptcy Report Last Update: 1/9/2020 03.02 PM

€ cancel ( lp Restart | [ Deactivate B Open Monitor More v
MName Type Platform RunlD Parent Status
3 E‘JOBP.ARSYS.TERED-’JU JOBF 1880156 & ENDED_CANCEL - m:

M @JOEP.ARSYS.TBREMG JOBP 1935312 |g2 ENDED_OK - ended n
» [FIOEF 1B B JOBF 1936051 &) ENDED_CANCEL - m:

v Fm innn anoaso TRNAanan 1nn ANTACT44 F rraimrm S ARICTL e



e Click Restart on the popup (no need to change options—these are meant for developers)

Restart JOBPARSYS. TBR2040

Parameters

Reference Run 1935312

Restart Point

QUEUE.COMMOMREGULAR_PRIORITY

Test Optiofis

Restart Cancel

e  You will be prompted to provide input, and can modify previous values before submitting the
task for execution.

Submitting a workflow to run at a future date/time

e From the My Catalog locate the workflow you wish to run in the Catalog pane

Favorites jﬁf‘ «

Catalog [=]

[ catalog » [ FINANCIAL AID

ROR1190: Tracking Letter Popsel ~
JOBPFINAID.ROR1190

ROR1200: OS5C Meed Grant Load P_..
JOBPFINAID ROR1200

ROR1290: Direct Loan Record Creation
JOBP FINAID.ROR1250

ROR1440: OFAX co-...

JOBPFINAID.RO 0 b Execute

ROR1450: Oregon Financial Aid Exch...
JOBPFINAID.ROR1450

Crf (D& ORf Ohf Chf




e Right-click the workflow and select Execution Options -> Execute Once

o A P P
Favorites R LU
Sl | Activities
[] catalog » [] FINANCIAL AID

- SHOW: | All
ROR1190: Tracking Letter Popsel s
JOBPFINAID.ROR1190
ROR1200: 05SC Need Grant Load P...

m o

NAID ROR1200

ROR1440: OFAX co-enroll file extract

~

Fl JOBPFINAIDLR

u == Open

RO:E%U,g [ Execution Options > | » Execute athenx
Ed Monitorin > |y Execute Once

o ROR1470-F BBV g o {:g

2] OBP.FINAID.H @' Move Egg Execute Recurr

@, ROR1530:C | . Duplicate b Restart

k]

Renlara

e Inthe resulting popup, click Test Options and check the “Activate attributes dialog” checkbox. If
you do not check this box, the prompts will not popup and you will have to cancel this job and
start over.

Click the “At Date / Time” option and enter the date and the time you would like it to run. Then
click Execute:



Execute Once JOBP.FINAID.ROR1440

Parameters

I (®) At Date / Time | THB/2020 IEI” 300 AM |

Use logical date |:|

Time Zone | PACIFIC -|
nias | |
Qusus | QUEUE.COMMON.REGULAR_PRIORITY - |

« Test Qptions

Activate attributes dialog [~] €@
Display in activation report:
Generated JCL []
Original script D
Modifications of variables [_]

Modifications of attributes [_|

Execute | | Cancel

Click Open when the blue popup appears:

Enter the prompts and click Submit:

VERY IMPORTANT !!!



< i  Requests

JOEP.FINAID.ROR1440 (1248222)

Filter Select ROR1440: OFAX co-enroll file extract

‘]OBPFINAIP'ROMMO : 09:02 AM 4 Submit ‘32 Cancel Task

ROR1440: OFAX co-enroll file extract

ROR1440

Run term 202002

e Go to Process Monitoring (see the following section for instructions on navigating to Process
monitoring and locating your workflow).

e |If necessary, add the Archive Key 2 column to the Process Monitoring menu by clicking the ~ in
the upper right corner and selecting “Archive Key 2”.

o The Archive Key 2 column displays the day and time that the workflow will run. The Internal
Account column will be populated if an Operator or a Developer submitted the job. This is
useful for Operations to identify the workflows that they submit manually for other
departments.

E Process Monitoring ~ +

E Top-Level Task (1) T

0 0 1 0
ABEND BLOCKED WAITING ACTIVE
e ¥R Resta & Deactivate B Open Monitor i Executions More @ Export Table
Type Name a | Users Status Activation Time RuniD Archive Key 2 Internal Accol w
y JOBP  TPJOBPFINAID.ROR1440 TANGUAYS/ONID @ Waiting for start time 3/20/2020 05:01:15PM 3372822 03/28/2020 03:00PM  DEVELOPER

Process monitoring

The process monitoring view displays all workflows currently running on the system. lts filter feature is
useful for finding past executions that have aged out of History or workflows run by a particular user.

e |f not displayed, use the pull-down to select the Process Monitoring tab



B wycatalog +-

Favorites Process Monitoring

Catalog ] Activities

[l catalog » [ ACCOUNTS RECEIVABLE
SHOW: = All

TBC1200: Updates the student’s rate code o1
\%’j JOBPARSYS. TBC1200

e [f necessary, expand the Name column to view the full name

P Process Monitering

Top-Level Tasks (3) = B t@ 08 3000
Cancel W3 Restart 5t Deactivate Bl Open Menitor Execution.
Hame E Flatform RunlD Parent Status
v T¥ JOBFFINAMCE FWRBREC JOBP 18280 I3 Active
» [ JSCH.FINAID.OPERATIONS JSCH 19329... I Active
¢ [ JSCH.FINANCE.FXR0185 JSCH 19267 I3 Active
Really handy filtering

e Click the Filter button

SWENSOMNJ/ONID

) DEV: 1300

£ Refresh 82s

t Export Table Unfiltered v Details

t Time ~ | Filter
9/2020 04:00 PM
9/2020 12:00 AM
9/2020 12:00 AM

== Add Filter Criteria

Task Name

YANLC

Display all workflows I have executed

e Select Filter/Add Filter Criteria
e Scroll and select User Object



(port Table Unfiltered ~ "{7 Filter i | Details

= ~ | Filter
120 04:00 PM

120 12:00AM | i Add Filter Criteria &—"

020 1200 AM | | a

Current Sync Usage
Queue
| Remote Status Number
Remote Status Text
Specific Task Properties
| Task Alias
Task RunlD

TirnI i rame

ZDU Version

Under User Object, click Current User (or enter ONID account)

Under Time Frame (add this filter if necessary), select Task Start and pick a timeframe from
which to display executions
Select Include deactivated tasks to show completed executions



e Click Filter to activate the filter

% Export Table Custom filter - ..-.../ Filter i Details
Filter

oF Add Filter Critesia

T E

[ ] Excluds

Task Type

User Object |

rrent User |:| Exclude

Time Frame o

(®) From 1.-'1.-'2323@ 12:00 AM

to 1/10/2020 [ 11:58 PM
() within last | 1 2| | Days

nclude deactivated tasks | §

.h_;. Filter Reset

Display past executions of a specific workflow

e Select Filter/Add Filter Criteria

e Enter the workflow name (partial names will work) in the Task Name field

e Under Time Frame, select Task Start and pick a timeframe from which to display executions
e Select Include deactivated tasks to show completed executions

e Click Filter to activate the filter



~ Export Table Custom filter i hf/‘ Filter i Details
~ Filter
= Add Filter Criteria

Tasl

TBR2040

Task Type

All

Status

All

Time Frame o

Task Start

(®) From | 1/1/2020 12:00 AM

to 11052020 11:53 PM

() within last | 1 | | Days

clude deactivated tasks i

-.__,:P Filter Reset

Saving custom filters

o After applying a filter, click Custom filter



e Click Save custom filter as..

ale Custom filter  ~ | ¥ Filter | §
Unfiltered
My tasks, ABEND
My tasks, ACTIVE
My tasks, BLOCKED

My tasks, WAITING

H Save custom filter as...
TS TR

Al

e Giveitaname

What to do if your workflow aborts

e If you do NOT know why the job aborted, leave it in Process Monitoring, and contact
ACT Support@lists.oregonstate.edu. ACT_Support is also emailed when there is an abort in
AWA, so they may contact you first.

e If you know what caused the abort (bad parameters, etc.), remove the abort from Process
Monitoring so that you can run the job again.

o Use the Process Monitoring filter to locate your aborted workflow

TANGUAY S/ONID

VK Administration [T Pre bty [ Process Monitoring Requests () Messages ror1620

DEV: 1300

Top-Level Task (1) T

. Refresh 38

0 1 Q 0 0
ABEND BLOCKED WAITING ACTIVE oK
Cancel b Restart Deactivate % Open Monior s Exccutions More  ~ Export Table Custom fiter ~ ~ || S Fiter | ' # Details
" £ g
Type Hame ~ | Users Status Activation Time runD W kirter
- JOBP %‘JUEP FINAID ROR1620 TANGUAYSIONID =) Workflow is blocked 11812021 01:25:43 PK 13764064
» JoBs /0B FINAD.ROR1620_SQR TANGUAYS/OND  [EJ ENDED_NOT_OK - aborted 1MBI2021 01:25:52 Pl 13755704 ] I Add Filer Criteria
JoBs “5J0BS.COMMON REG_AND_SEND_FILES TANGUAYS/ONID E;J"f\'ailmg for predecessor 11812021 01:25:52 PM 13755705 Task Name
ROR1620
[ Exclude
Task Type
Al
Status
Al

o Right-click on the workflow (JOBP) and select Modify -> Cancel (Recursive)


mailto:ACT_Support@lists.oregonstate.edu

@ Process Monitoring Reguests () Messages

Top-level Task (1) ¥ = | E

0 1 0 0 0
ABEND BLOCKED WAITING ACTIVE oK
$ cancel  ip Resta % Deactivate =} Open Monitor &4 Executions More  ~ i Export Table Custom fiter v | | 55
Type Hame *  Users Status Activation Time RUD ¥ Figer
~ J0BP TJ0BPFINAID.ROR1620 TANRIAYS/ONID & Workflow is blocked 118/2021 01:25:43 PM 13764064
y JOBS. :£J0BS FINAID.ROR1620_SQ = apen Monitor BYSIOND  [EJ ENDED_NOT_OK - aborted 1182021 012552 P 13755704 | i Add Fiter Crieria
JoBs “£J0BS.COMMON.REG_AND, = OPen Report BYS/ONID [E watting for predecessar 11812021 01:25:52 PN 13785705 | o
Open User Input Dialog
ROR1820
B8 execution Lists »
. Modify 31 5% cance then [ Exciude
i Detais 4 | G cancel (Recursive) & then Task Type

Comments © Suspend

Al
H Create Forecast 0 Suspend (Recursive)

Status
T Source Object > Modify Priority

Modify Status Manually

Take Over Task

o Resubmit the workflow.

Notes and known issues

e Cannot find a job or workflow using Search
o Thisis a known behavior. The catalog is not currently included in the search function.
We have submitted a request to the vendor to add this feature
e Ascreen doesn’t show real-time data
o The refresh rate is set to 90 seconds. Some screens display a countdown timer, others
do not.
o Click the green arrows/refresh button to refresh the screen manually

uests @ Messages Search

History

Today - Wednesday, January 8, 2020

12:00 PM
e The History screen shows executions started by others
o The history pane under My Catalog displays the history of workflows you have executed.
o Ifyou click on an item, a History screen will open which displays the past 50 executions
of the selected workflow—by any user—and highlights your selection. That history
screen is not user-specific.
o For a more extensive user-specific view, use Filters in the Process Monitoring view.
e When Restart is used to execute a workflow, and input values are altered before the workflow is
executed, those values will be modified in both the newly-run execution and the execution
selected to be restarted.

Ll—_vp TBR2040: Accounts Receivable Bankruptcy Report

7, Refrash S1s

Fitter

i Details.



Additionally, if you begin to restart a workflow, but cancel before entering input values, the
previous run’s input values will be erased.
o The software is behaving as designed. We have submitted an idea to the vendor to
modify this behavior to *not* modify the input values of the past execution.
o If this happens and you need to view the original input values for a past execution, do
the following:
= Locate the past execution in History or Process Monitoring
= Right click the workflow name and select Open Report.
=  Use the pull down menu above the displayed contents and select Activation
(ACT)

¢ «~ Report of JOBP.FINAID.ROR1930
Title: ROR1980: Study Abroad Student Report by Term

Script (REVD) O Page 1 i

\ Soipt {(REVD)
g801:-: 0015 lines =suppressed “*
Object scoess (REVZ) lve war("1320")
- N 1?:_?;:[‘2E2EEE":
FELETET LT lve war('202001')
Directony

ddaa EL‘:I.':i.Pt- ddaa
/b

4ass THCLUDE jobi.common.all workflows «<Date:2015-1
/b

4asd TRCLUDE jobi.common.get_top info «Date:2015-12

=  The input values (incrementally numbered in the order passed) will be displayed
at the top of the page as variables beginning with “&P”

Activation (ACT) Fage r__J-——

"gP01%" wa= =tored with wvalue "1320°".

2020-01-13 11:23:20 - TO002020€ Variakble
2020-01-13 11:23:20 - TOQ02020€ Variable ['sP02$' wa=s stored with walue "202000°.
2020-01-13 11:23:20 TO002020€ Variablef 'sP03f' wa= =tored with value "202001".
2020-01-13 11:23:20 TO2023237 The cobkje variable "SREQUESTCR{' in cbject: I.C0MEC
2020-01-13 11:-23:-20 To00020206 Variable '& -5 T SWEN3CNI" _
2020-01-13 11:23:20 TO2023237 The ckject variabkle "sRECIP in ockject: "JOBI.COMM
2020-01-13 11:23:20 TU00020206 Variable 'srecipient=f' wa= stored with value "'.
2030-01-13 11:23:20 - TO00030237 The ckject variable "SEMAIL 3UBJECT{" in ocbject: "JOBI.C
2020-01-13 11:23:20 - T0002020€ Variable ‘&Ema:il_zu.b:'zr.'f-#‘ was stored with value "".
2020-01-13 11:23:20 - T00020237 The cbiject variable ":DE INST§" in obiect: "JOBI.COMMON.

Can’t scroll to all the workflows you should see in the Catalog
o Note that workflows that have not yet been converted or made available for testing
won’t be listed. If you think they’re present, but you can’t scroll to them, keep reading.
o Chrome is recommended, but seems to have some quirks. We’ve noticed it sometimes
won’t scroll to the bottom of the catalog
= The problem can be worked around by increasing the ZOOM level on the
browser to 200%, but the vendor has not been able to reproduce this
= Alternately, try another browser
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